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Summary



About this document

While Notes is so much more than just an email, calendar, and contacts application, it is
usually among one of the most important features of the client.

Outlook is the email and scheduling client with the largest user base. This means that if you
get new employees in your company, they were most likely Outlook users in their previous
position. If you are using Notes for email and calendaring, there will be a period of
adjustment for the employee.

In the past 15 years I've had several user training sessions for users that comes from the world
of Outlook to the world of Notes. This posting is therefore built on my long experience about
what the usual questions and challenges are.

This article will hopefully help you make the transition smoother and make it easier for the
employee to adapt to working with Notes. | have therefore included tips on how you can set
up the client to mimic Outlook behaviour (like opening everything in new windows).

In addition, | have described how you use a lot of the functions that Outlook, and Notes have
in common, that might be a bit different in Notes.

| also think this article will be of great help to users who have used Notes for years.



Notes client settings and functions

Open documents in new windows

In Outlook, any document that you create or open will appear in its own window. This is of
course possible in Notes as well.

1. Go to the menu File and choose Preferences
2. Click on Windows in the Preferences screen

3. Select Open each document in its own window under Window Management:
type filter text Windows
Accounts

Basic Notes Client Configu
Calendar and To Do

On restart, reopen any tabs that were open when | closed the client
Use large icons in the Open List

1

Composite Application Edi Inform me that | can return a panel to an application from the View menu

Contacts Inform me that | can return a panel to the sidebar from the View menu

Fonts, Colors and Themes Window Management

Live Text Choose how you want to open documents. Documents that are already open will not be affected until you close and reopen
Locations

Log Settings (® Open each document in its own window

Mail

(O Open each document in its own tab
Notes Ports

Ragianal Satfings (O Group documents from each application on a tab

Replication and Sync
Sametime

Search

Spell Check N
Toolbar

Widgets

Windows

XPages Performance

4. Click Apply and then OK

5. Every window and document will from now be opened in its own window

PS! You can also open any Notes document in a new window at any time by right clicking on

it in the view or folder and choose Open in New Window

Preview pane

Just like in Outlook, you can choose whether you want to have a preview pane for your email,

calendar and to do entries, and if it should be displayed at the bottom or to the right.

Click on button named Show to the upper right, above the mail, calendar or to do folder you

are currently working with:

Show vm () Sametime Contacts

Preview on Bottem
® Preview on Side

Hide Preview
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You can also control whether you want the email or document to be marked as read or not
when it's been displayed in the preview pane:

1. Go to the menu File and choose Preferences
2. Click on Basic Notes Client Configuration in the left side menu
3. Inthe big Additional Options field you check Mark documents when opened in

preview pane if you want the the emails or document to be marked as read after being
displayed in the preview pane. If you don't want that, you have to uncheck this option:

Preferences O
type filter text Basic Notes Client Configuration =R
)BQcc.our:tz Client Confi Startup and shut down
asic Notes Client Copfigu
Empty trash on application close Local application folder:
» Calendar and To Do {f not emptied at a timed interval): l y g + - -
»  Composite Applicatiory Edi - = C:\Program Files {x86)\HCL \Notes\Data
v
Contacts it Check subscriptions
Fonts, Colors and Themés [JAutoSave every [15 =] minutes [] Scan for unread
Live Text 52
e [[] Enable scheduled local agents
Locations
Log Settings '
Displ
Mail e |
Notes Ports | Default Fonts...
» Regional Settings
Replication and Sync Additional options I}
Sametime l v Mark documents read when opened in preview pane A
. Search 7
Spell Check Textured Workspace
4. Click OK

PS! You can also mark a read document as unread or an unread document as read by hitting
the Insert button on your keyboard

Shortcuts

In Outlook you have shortcut icons for the mail, calendar, and To do in the lower left corner.
In Notes you have several ways to get shortcuts for Mail, Calendar and Contacts:

Shortcut buttons

Click on View -> Show Shortcut Buttons and choose Mail. Then repeat this for Calendar
and Contacts:
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lit View Create Actions Tools Window Help

I Refresh Fg

v Search This View
Toolbar >
Show >

Expand/Collapse >

f# Hogne Beg Pettersen - (
LR = | [
New v Reply ~

Customize This View...
Search in View ‘In|

Go To... e
Starts With... Searchfor |
Agents
Design Il
Scott Vrusho
Image Resources...
HCL Nomad fd
v Advanced Menus Good Day, For
Right Sidebar >
Right Sidebar Panels >
v Dockthe Open List
Show Shortcut Buttons > + Mail D
Calendar
Chat History Coniacks
Views Home
Workspace
~ Folders .
Discover
I Archive Thumbnails
N4 15

You will now see these shortcut buttons under the menu line:

File Edit View Create Actions Tc
Unfortunately To do is not available as a shortcut button.
Bookmarks

However, To do is available as a bookmark, together with Mail, Calendar and Contacts.
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You find these bookmarks under the Open button:

Type to find

e Mail
@8 Calendar
2 Contacts

¥ To Do
() Replication and Sync
@ Domino Administrator
#5 Domino Designer

% Favorite Bookmarks
[t Applications

More Bookmarks
© Internet Explorer Links

@ Discover
A Home

You can pin the bookmarks under the Open button to be permanently visible by right clicking
on the Open button and choose Dock the Open List. You can also choose Use Large Icons.
Now Mail, Calendar, Contacts and To do will have permanent shortcuts to the left in the
Notes client:

Q Hogne Bg P
on Local
WA Inbox
E Drafts
1 Sent
7 Follow Up
u All Document
() By Sender
.. Junk
ﬁ Trash
= Chat History
* Views
g} ~ Folders

I8 Archive
I Drafts
| Ferdig

DO 3
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Spell checking

Spellcheck can be done in any rich text field, both in emails, calendar and to do entries, and

documents in other Notes applications.

Turn on spell checking

1. Go to the File menu and choose Preferences

2. Click on Spell Check:

type filter text
Accounts

Basic Notes Client Configu
Calendar and To Do

Composite Application Edr

Spell Check

Installed dictionaries for Norwegian
Primary Dictionary:

Supplemental Dictionaries:

Hungarian

Contacts ltalian {Standard)
Fonts, Colors and Themes ' ftalian (witzeriand)
Eive Teit 17 Norwegan Bokmal)

: Norwegian (Nynorsk)
Locations !

) Polish

Log Settings Part imiiaoa (Reaill b
o | Setas Defaut | | Edt User Dictionary.. |
Notes Ports as Defau Edit User Dictionary...
Regional Settings )
Replication and Sync Defautts for Norwegian
Sametime [[] lanore words containing numbers
Seaych [Jlgnore words in UPPERCASE
Spell Check
Tooldsr [[] Keep on the fly dictionary changes until next language tag change
Widg
Windo Enable Instant Spell checking
XPages Pgrformance Instant Comrections

Comect common typing errors {for example, replace teh with the)

[MCapttalize first letter of every sentence:
Comect TWo INitial CApitals

3. To activate spell checking, click on Enable Instant Spell checking
4. You can choose the default language from the list Primary Dictionary (if it's not
there, contact your administrator to have it installed), by clicking on it and then
clicking on the button Set as Deafult
5. Set any other settings you want and click OK
Using spell checking

After turning it on, spell checking will now be performed in all rich text fields. Notes will
underline spelling errors with a red line:
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From: Hoane Be Pettersen/ELFWORLD

This is a wrad thatis spelled wrong

Hnnna Rax Daftarcan

The spell check in Notes is not nearly as advanced as in Outlook, but it's still very helpful.
Spell checking several languages at once

Outlook will automatically detect what language you write in while spell checking. So if you
change from Norwegian to English, and both of these languages are installed on your

computer, it will change the spell checking to the language you are currently writing in.

Notes doesn't do that. If you want to spell check in another language than the default
language, you have to manually change what language you want to use for spell checking.

Here is how you can spell check more than one language at once in Notes:

1. Write the text:

Norsk:
Dette er et ordd som er stavt feil

English:
This is a wrod that is spelld wrong| I

2. Highlight the text you want to spell check in a different language from the default
language:
Norsk:
Dette er et ordd som er stavt feil

-nglish:
This is a wrad that is spelld

wrongl

3. Hold down the CTRL key on your keyboard and hit th K key. Or go to the menu Text
and choose Text Properties:
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ns | Text Tools Window Help

l Text Properties [} Ctrl+K

detts Permanent Pen >

# Highlighter >

4. In the popup window, go to the Language field at the bottom and choose the desired

language:
Text > Lt 85 A 3
a |l= el == e
Font Size Style
Corbel Light H A 8 A VPan A
Courier 9 Bold
Courier New p ttalic
Cudz MT T 11 ¥  Underdine
Debussy by ~ Strkethrough
Default Monospace ¥ 10 ¢  Superscript ¥
Default MuttiLingual
Default Sans Serif  MUCANecd R4
Language | v
Norwegian Bokmal A
English
Untagged
Unknown
Afrikaans
Albanian
Arabic
Arabic(Algeria)
Arabic(Bahrain) v

5. The language will now be changed for the highlighted text:

Norsk:
Dette er et ordd som er stavi feil

English:
This is a wraod thatis spelld wrong

Rich text formatting in HCL Notes
Rich text fields are fields in Notes where you can format the text with colors, photos, tables,
different types of fonts and so on. The email body field (where you write the message text) is

an example of a Notes rich text field. Rich text fields are also in calendar and To do entries
and they can also be in any Notes application you use.

You can format the text in a rich text field in most of the ways that you are used to:
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Description

Attach...

Create a table:

You can format a text in many ways. :[

Like creating a headline

Changing the font Change the colors Change the font [Have a list
size 1. Orone
2. Ortwo
3. Orthree
And use Have it in bold, /talic, ‘
lunderlined and so on
: Bullet WY# HCL Ambassador
oints
e To =
o Get And have pictures!
® Your
* Point
® Across

There is a toolbar for all these formatting options above the document, under the row showing
all your open windows and documents:

Default Sans Serif

<
o
o
b
N

|

|
I
I
1]
Il

o— i

1= a4 &

o= J=m

If you can't see this toolbar, it could mean that it's either turned off, or that you aren't in a rich
text field right now. You can check this in the menu View -> Toolbar:

View Create Actions

F

8«

Refresh

Ruler
Toolbar
Show

Parent Preview

Document Link Preview

Image Resources...

Expand All Sections
Collapse All Sections
Switch Ferm...

Go up to Parent View

Encoding

Advanced Menus

Tools Window Help

F9

Ctrl+R Ra Pettersen - Calendar <, Hoane Ra Pet
> Address

> & Editing
Language
Mobile
Navigation
Table Properties
Shift + Text Properties [}
Shift - Universal
View

v Widgets

Show Toclbars Only When Editing
Hide All Toolbars
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Make sure Text Properties is checked. If you choose Show Toolbars Only When Editing,
the toolbar will only show up when you are in a rich text field. If Hide All Toolbars is
checked, all toolbars will be hidden all the time.



Mail

Creating a new email

Creating emails in Notes is very similar to how you do it in Outlook.

1. Click CTRL + M to create a new email (or click the New button if you are in mail

folder). You can do this even your mail application isn't even open in Notes

2. To add email addresses you can simply start typing the name or address in the To, Cc
or Bcc field (if the Bec field isn't displayed, click on the button called Display above

the mail form and choose Bcc). You can also click on To:

f

. IQ:;I
N,

From: Hogne Be Pettersen/ELFWORLD

a) You will now see this popup:

Select Addresses

Choose the directory, then type all or part of the name.
Directory: ELFWORLD's Directory

Find names starting with: [| L

& Administration Requests

i R VORLD

& Domino, Admin

& |BM Notes/Domino Fault Reports

& |BM Notes/Dominoe Smart Upgrade Tracking Re
& LocalDomainAdmins

& LocalDomainServers

< >

| Details... Add to Contacts

Tip: You can drag and drop the names

BB

View by: List by name v
Recipients:
To:
= cc:
= bec:
‘. RemoveJ | Remove Al ]

| OK I | Cancel j

V7

b) You can now select people from your company directory. If you want to add people

from your personal Contacts, change to your Contacts application in the Directory

pull down field:
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Choose the directory, then type all or part of the name.

Directory: ELFWORLD's Directory

Pettersen’s Contacts
Find names starting with: (ELFWORLD's Directory
Local Address Books
& _Administration A Bigfoot

ik domino-42 elfwliensign

c) You can use the Find names starting with field to type the beginning of a person's
name to find the person you are looking for, if you don't want to scroll through the list.

d) Use the buttons to the right of the address field to add people and addresses to the
To, Cc or Bec fields

e) Click OK

3. You can now write your email. To add attachments you can simply drag and drop files
into the email.

Flag an email for follow up
You can flag an email for follow up simply by right clicking on the email:

© Yesterday

sel

Case update: service@paypal.com

Hello, Hogne Pettersen An updateills WERCEIG)!

- P> QuickFlag 5
Case opened: _ B Move to Folder...
Hello, Hogne Pettersen We recen Markas 5

You can also mark one or more emails and then hit the flagging button above the folder:

v P~ M El~- More~

Quick Flag
— Add or Edit Flag... l}\

Remove Flag

Cnrt hu Nata w H

Under Add or Edit Flag... you can set due dates and a lot of other settings. Read all about
flagging of emails in this tip.

You can see a view of all your flagged emails if you click on Follow Up in the left side menu
in your email. You can also see them constantly listed in the left side menu by scrolling down
to the bottom of the left side menu.


https://domino.elfworld.org/notes-tips-19-flag-an-email-for-followup/
http://domino.elfworld.org/wp-content/uploads/2021/03/64.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/04.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/05.jpg

Click on the small arrow:

» Archive

» Tools

» Other Mall

PS! If you have Notes V11 or newer, you don't need to look for this small arrow. You can just
expand the menu item called Show Mini View.

After clicking on the arrow you can choose Follow Up in the pulldown menu that appears:

1
' New Notices™

Follow Up h
New Notices Su
To Do au Tea

Now the list of emails you have flagged will be displayed in the left menu.
Turn an email into a meeting or To do

To turn an email into a calendar entry, such as a meeting invite, or a To do, by right clicking
on the email and choose Copy Into New:

DRSS Z 1mar 9:48|
3 Forward |
ik
St Copy Into New h> Message
ne Open in New Window Calendar Entry
Gi d=h Print... Ctrl+P ToDo
M Delete Del W

If you click on Calendar Entry you can choose what kind of calendar entry it should be. A
pop up will appear, and if you select Meeting, it will prepare a new meeting document. Notes
will automatically populate the invite fields with all the people in the To, Cc and Bcc fields.

See your calendar while using your email
In Outlook you must actively choose to display your calendar in the right sidebar. In HCL

Notes, it's always there for you, and unlike Outlook it will also show entries from any
imported calendars (Outlook only displays your main calendar).


http://domino.elfworld.org/wp-content/uploads/2021/03/43.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/44.jpg
http://domino.elfworld.org/wp-content/uploads/2021/03/06.jpg

Simply click on Day at a Glance in the right sidebar panel, and you can see all your
appointments for today:

v SUGINTUINTG LuUnwauwwy

Il

f=] Day-At-A-Glance

Thu, Mar 4, 2021
09:20 - 10:20
Legetime
Derjeger
11:00 - 14:00
Digital Week Comes To You EMEA - Day 2
Join the event at https://hclsw.co/ds-dw-emea-
attend
hcl_digital_solutions_events

16:00-17:00

Meet-Up - HCL Connections Guide Program
Exchange
hitps://ht-group.zoom.us/j/95794941629
L

Week 9- 43 weeks leftinthe year ~

| Today | Mar 5, 2021

1 March 2021

M TWTF S S

{7 G
8 910 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25 26 27 28
29 30 31 '

You can click on the arrows to navigate from one day to the next, and you can navigate
through the months in the calendar underneath the calendar entries.

To get back to today, click on the Today button.

PS! If the right sidebar panel isn't visible, just click CTRL + 9 on the keyboard.
Quick rules

Like in Outlook, you can create quick rules based on the currently selected email:

1. Click on the email you want to create a rule from
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2. Click on the More button above the folder and choose Create Quick Rule...:
|+ Morer QY Q-

Preferences... i like c
e Out of Office...
Copy Into New >
rt by Add Sender to Contacts...
Deliver Sender's Mail to Junk... - wol
: tnet i
Schedule a Meeting ...
VIoos
New Message with Stationery...
Mark/Unmark Document As Expired... iiskic
Create QuickRule... h
Mail Rules > ——

1] Looabay,

3. You will then get a popup window where you can choose what should trigger the rule:

Create QuickRule 2%

Create a Rule based on information in the selected document.
Note: The rule will act on new incoming messages. Mail in your Inbox will not be affected.

1 Selectthe conditions to match

[~ When Sender contains v _@pnp—hcl.com |

[~ When Domain is v Ipnp—hcl.com |

[V When Subject contains v IHCL Nomad for web private beta on-prem av:l

2 Decide when to take action

¢ When at least one of the selected conditions is met
" When all of the selected conditions are met

3 Choosethe acﬁonT-a perform

¢ Move to Folder Under arbeid [ Selact. |
" Change importance to High ————:

" Do not accept message
To work with this rule in the future, go to the Rules folder, under Tools.

' Run Now On Inbox... ‘ Run Now On All documents... I OK ‘ Cancel

In the example above | have set it to the following:
Under 1 | have set the condition to match the displayed Subject

Under 2 | have chosen that at least one of the selected conditions under 1 should be
met. This is not necessary here since | have only selected one condition, but you do
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have the option for selecting more than one.

Under 3 | have selected that emails matching this rule should be automatically moved
to the folder Under arbeid. You choose a folder by clicking on Select... and you can

also create new folders in the popup window that will appear

Bonus tip if you have Notes V10 or newer: If you want this rule to be triggered on
emails that already are in your inbox, you click on Run Now on Inbox....
it to trigger on matching emails no matter what folder they are in you click on Run

Now On All documents....

4. Click on OK when finished

From now on all emails with that subject will automatically be transferred to the selected

folder.

You can administer your rules, as well as create even more complex rules, by clicking on the

More button and then selecting Mail Rules -> Manage Rules:

Morev () Q-+~

Preferences...
— QOut of Office...

Copy Into New
b Add Sender to Contacts...
Deliver Sender's Mail to Junk...

Schedule a Meeting ...

r New Message with Stationery...
Mark/Unmark Document As Expired...
Create QuickRule...
Mail Rules

G000 DAY,

Mail signature

Creating the signature

You create your email signature like this:

1. Open any folder in your email

l like current view Vl @ Inde

Q

net to targeted compa

\

!

T web private beta on-g
rvroosh

vrusho@pnp-hcl.com>

|
Manage Rules h (

Run Rules...

If you want
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2. Click on the More button above the folder and select Preferences...:
|+ Morer T) Q~

Preferences...

like ¢
— Out of Office... D? ‘
— Copy Into New >
irt by Add Sender to Contacts...
Deliver Sender's Mail to Junk... wek
Schedule a Meeting ... ot
VIoos
New Message with Stationery...
Mark/Unmark Document As Expired... Irusha
Create QuickRule...
Mail Rules > F—

—H-vvery,

3. You will now be taken to the Mail preferences window. Click on the Signature tab:
Mail l Calendar & To Do | Access & Delegation | [ ok

Basics l Letterhead | Signature I ~ollow Up I Sender Colors I Recipient Icons I Swiftfile I \.ﬂ

v EAutomatically append a signature to the bottom of my outgoing mail m&esagesé

New Messages l Reply and Forward Messages I

A signature for new messages.
Type of signature: I
% Rich Text " Plain Text " HTML or Image File

Use a rich text signature to use text formatting, graphics, and other rich text features. Once you set it, the
signature will appear on any computer where you use Notes.

To add text, graphics and attachments, use the "T" control below.

To use additional rich text features (such as fonts and links), create your signature in a rich text field
elsewhere (such as the body of an email) copy it, and paste it here.

Note: Rich Text signatures will work only if all users of this mail file are using Notes 8.5 or higher.

\ Append My vCard J @

P

Hogne Bo Pettersen

IT-consultant, writer, photographer and speaker
+47 911 93 144

https://domino.elfworld.org

hitps:/fabout. me/hbpettersen/

\‘l HCL Ambassador

T
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4. Check Automatically append a signature to the bottom of my outgoing mail
messages to make sure the signature is always added to your emails

5. You have the following signature types:

Rich Text: Here you can add formatted text, hypertext links and images (like in the
image above)

Plain Text: Here you can add nothing but a pure text signature. This will be added
whenever you send an email as pure text, or you manually select it before sending an
email

HTML Image or file: If you choose this, you will be asked to upload an image file or
an HTML (web) file

6. Some people like to have a different signature when they reply to, or forward, a
message. You can therefore click on the tab Reply and Forward Messages, where

you will get these options:
¥ Automatically append a signature to the bottom of my outgoing mail messages

New Messages Reply and Forward Messages

A signature for reply or forward messages. If default is selected. the new messages
signature is used.

Type of signature:
" Rich Text " Plain Text " HTML or Image File

Default: If you choose this, it will use the same signature you set for New Messages

Rich Text: If you choose this you get a rich text field where you can create a totally
different signature with formatted text, hypertext links and images

Plain Text: If you choose this you can create a different pure text signature

HTML or Image File: You can upload a different image or HTML file to use as a reply
or forward signature

7. Click on OK when finished
The signature will now always be added to your emails.
Different signatures
In Outlook you can have different signatures for different purposes and email accounts. This

is not possible in Notes, but what you can do is create image or HTML files with alternative
signatures. Add them to a folder on your PC or network drive.
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If you want to use an alternative signature, you do it like this:
1. Create a new email or reply to an email
2. Place your cursor just above your standard signature (this is important!)

3. Click on the Signature button and choose New Signature from File...:
& | Signaturev  Displayy  More¥
——— & Default Signature

— New Signature from File... [}
— No Signature

4. Your standard signature will now be removed from the email, and you will see this
popup window:

Include S_ignature [ZI E

Import from File (TextHTMLU/Image):

” | [ Concd|
Browse |

: J You can automatically:a[ppend a signature to your
i messages on the Signature tab in Mail Preferences.

5. Click on Browse to find the signature file

6. Clickon OK

7. The signature will now be added to your email, instead of the standard one
Mail conversations

Just like in Outlook, you can in Notes choose whether you want the emails in a folder to be
displayed as conversation threads or not.
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You do this by clicking on the Show button in the upper right corner of the folder, and choose
Conversations:

Show »~ <) Sametime Contacts

Preview on Bottom
® Preview on Side

Hide Preview =

v Individual Messages

Conversations [}
k
202 Unread Only
lide &
Group By Date

v Beginning of Message

0T

Notes does have a functionality here that Outlook doesn't have. Whenever you click on an
email that is a part of a conversation thread, even if the entire folder is set to display
Individual Messages, you will still get a twistie to the left of the email:

e

[[©]sv: jueniisen &

If you click on this, you will still be able to see the entire conversation, even if the folder is set
to display individual messages only.

Notifications

Like in Outlook a sound will play, you will get popup notifications and/or a slide in summary
and an envelope icon will appear in the taskbar when a new email arrives.

You can control these notifications by clicking on File -> Preferences and then expand Mail
and choose Sending and Receiving. Under the section called Receiving you can choose what
notifications, if any, you want:
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v Mail [] Sign messages that | send

DecessandDielegation Add forward prefix to the subject of forwarded mess
Internet
Sending and Recwng Receiving
Notes Ports
Regional Settings Check for new mail every minutes
Replication and Sync When new mail amives:
DAty Refresh Inbox automatically
Search ‘ :
Spell Check [JPlay asound | Browse... l
Toolbar Aetts:
Widgets
Windows © Show a popup
XPages Performance () Slide in a summary
(® No alert

[] Display an icon in the system tray

Out of office

Like Outlook, Notes gives you the ability to set up an automatic reply that should go out to
people who send you an email. In Outlook it's called Automatic Replies, while in Notes it's
called Out of Office:

1. Click on the More button above the folder and choose Out of Office...:
B~ Morer §) Q~

Preferences... i-
_— Qut of Office... %
Copy Into New >

Sort by Add Sender to Contacts...

2. You now get the Out of Office form in Notes. Here you can set the date for when you
are leaving, whether you should be available for meetings or not (people will see you
as busy when checking your schedule if you choose not to be), a subject for the
automatic reply and the mail message itself.
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3. You can also set an Alternate notification:

Standard Notification I Alternate Notification I Exclusions I

To send an alternate out-of-office notification to certain people, specify the people in

[ Reset Defaults ]
oo I

Subject: lHogne Be Pettersen is out of the office

¥ Append return date to subject

Body: | am out of the office until 07.03.2021.

Additional
body text:

By clicking on To, you can choose people from your personal contact list, as well as
the corporate directory, who should receive an alternate notification. You can also add
emails directly in the field to the right of the To function. You then set an alternate

subject and message text.

4. You can also set up who should not get an Out of Office message from you under
Exclusions:

Standard Notification I Alternate Notification l Exclusions

To cancel the out-of-office notification when certain conditions are met, specify the conditions below.

_ Reset Defaults ]

[~ Do not automatically reply to mail from Internet addresses.

A message is sent by any of these people:

*hotmail.com |

Sent by:

A message subject contains any of these exact phrases:

| I [ Add PPKase ]
Nigerian prince Remove Phrase

In this example | have set that any email sent from hotmail.com you should not get an
automatic reply. | have also added that any message containing the phrase Nigerian
prince in the subject shouldn't get a reply either. You add a phrase by entering it in the
field A message subject contains any of these exact phrases and then click on Add
Phrase. To remove a phrase, click on it in the big square, and then click on Remove
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Phrase.

5. When you are finished you can click on Enable and Close at the top if you want to
activate the Out of Office agent. If you have set it to start at a later date, it won't start
sending out automatic replies before the selected date and time has been reached. If

you click Save and Close, you will only save this as a draft, and it will not be
activated.

Spelichecking your email

Spellchecking while writing

Check the spell checking sub sections in the Notes client settings and functions section above
Spellchecking before sending

You can also do a last spell checking before sending the email. It will also spell check the
Subject line.

Here is how you turn this on:
1. Go to File -> Preferences

2. Choose Mail in the preferences window:

Log Settings Message Options
v Mail [V Spell-check messages before sending
Access and Delegation ¥ Warn me about blank message subjects
Internet [V Always show details in received Mail messages

~ - rn oem P —_ - —_

3. Make sure the Spell-check messages before sending option is checked under Message
Options

4. Click OK

When you now write an email, and hit send, Notes will spell check the Subject line and the
main text of the message:
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L L
Subject [B388 pa norsk og English

From: Hogne Be Pettersen/lELFWORLD

Kok Spell Check [} { 2]}
Dette er et grdd som er stavi feil ' '

Not in dictionary lm l ™y Skip | Skip All I
English: S :
This is a wrad thatis spelld wrong g Eg;sa o Replace |

0S
gosa Replace Al |
Hogne Bo Pettersen Addto Dictionary _ |
IT-consultant, writer, photographer ¢ Edt Dictorary... |
+47 911 93 144
https://domino.elfworld.org Dictionary: Default - Norwegian (Bokmal) v
https://about. me/hbpettersen/ Syieling Options...
’ {"] Checking entire document | SendAsls [ ] Cancel Send
WY# HCL Amba

e You can choose which language you want to use as Dictionary

e You can skip a word and jump to the next or you can skip all by just clicking on Send

As Is

e You can choose a suggested word from the list, or type your own correction, and then
click Replace. Notes will then jump to the next misspelled word
e You can add a word to the Dictionary, so that Notes won't claim that it's misspelled

the next time

e You can click on Spelling Options... to tell Notes to ignore words in uppercase and

with numbers

Prevent sending emails with blank Subject line

1. Goto File -> Preferences

2. Choose Mail in the preferences window:

Log Settings Message Options
v Mail v Spell-check messages before sending
Access and Delegation ¥ Warn me about blank message subjects
Internet [V Always show details in received Mail messages

~ - (Y ou . .

-

3. Make sure the Warn me about blank message subjects option is checked under

Message Options

4. Click OK

Notes will now warn you if you try to send an email without a subject line

Formatting email text

Check the Rich text formatting in HCL Notes sub section in the Notes client settings and

functions section above on how to format text in an email.
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Set default email font

You can change the default font in email in this way:
1. Write a text with the font that you want to set as a standard font
2. Highlight it:

Subject: |

From: Hogne Be Pettersen/ELFWORLD

ﬂ his is the font | wantto use

Hogne Bo Pettersen
[T-consultant, writer, photographer and speaker
+47 911 93 144

3. Go to the Text menu and choose Set Current Font as Mail Default:

15 Text Tools Window Help

I Text Properties Ctrl+K I

atty Permanent Pen > i
» Highlighter >
Pass-Thru HTML
Normal Text Ctrl+T n
7 ltalic Ctrl+l [
l b Bold Ctrl+B  —
l U Underline Ctrl+U L
l Strikethrough =
t l Effects > 1
| Color > |
Enlarge Size F2
Reduce Size Shift+F2
5e Align Paragraph >
er. List >
NG Spacing >
B *=  |Indent F8
*=  Qutdent Shift+F8
’ Apply Style >
k l Set Current Font as Mail Default N
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4. Notes will confirm your choice:
Set Current Font as Mail Default X

You have set the following as the default font to use when composing
mail messages.

Font: Default Sans Serif

Size: 10

ot

5. Click OK

Now Notes will always use this as your default font in emails

Add another email account

Unfortunately, you cannot add another email account to Notes like you can in Outlook.
What you can do is create group mail applications that you can open like you open your own
email. You can also be given access to other people’s email, which you then can open up like

your own mail application.

However, these will be in their own windows in the Notes client, and not collected in the left
side menu, like in Outlook.
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Calendar

Share your calendar
You can share your calendar with other users.
1. Go to the menu File and choose Preferences

2. Click on Calendar and To do and then on Access and Delegation:
Preferences O

type filter text Access and Delegation Gl

> Accounts

Basic Notes Client Configu y 7
« Calendar and To Do Mail | Calendar & To Do ] Access & Delegation
Access and Delegation Access to Your Mail & Calendar l Access to Your Schedule | Shortcuts to Others' Mail
Regicnal Settings . :
You can give one or more people or groups access to your contacts and to all or part of your mail file

> Composite Application Edv (Mail, Calendar and To Do). and you can control the actions that each delegate is allowed to perform.

E::ttsac;;ors arid Thertias To delega?e access to your Contact_s, you must also enable the Contacts preference labeled "Enable
¥ 'Synchronize Contacts' on the Replicator.”

Live Text

Locations For Mail-In-Database Only:

Log Settings ™ Enable Alternate From Feature
5 Mail [T Automatically use internet address of Mail-&database as sender

Notes Ports
. Regional Settings Mail. Calendar. To Do. and Contacts

Replication and Sync Delegate access to these people or groups:
» Sametime ‘ Add.. ‘
> Search ‘

Spell Check ‘ Remove ‘
» Toolbar

Widgets

Windows

Aeages Destormionce No other people or groups have been delegated access to your mail file
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3. Click on Add....
Aqd Peogle/Grougs [Zl E .

Person or Group

To whom do you want to give access to your mail file?

i

[ cancel
" Everyone ‘ o

& Justthis person or group:§ g a

Components

Which components of your mail file do you want to give access to?
" Mail, Calendar, To Do and Contacts

* Calendar, To Do and Contacts

" Calendar and To Do

" None

Access

How much access do you want to give for Calendar, To Do and Contacts?

Read v

Automatic Forwarding

Enabling automatic forwarding makes it easier for someone to manage your calendar when it is not
open and on display. These settings apply even if no components are delegated, and they apply to all
auto-forwarded messages.

Forward calendar notices | receive for meetings where:
™ 1am the chair
™ | am a participant

For notices associated with calendar entries | have marked as private:

Do not forward v

4. You can under Person or Group choose if everyone should have access, or just the
persons or groups that you add by clicking in the field to the right of Just this person
or group

5. Under Components you select what they should have access to

6. Under Access you choose if they only should be able to read your calendar, or if they
should also be given full access (there's nothing in between)

7. Click OK when finished
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8. You will now see the person and how much access they have:

Mail. Calendar. To Do. and Contacls

Delegate access to these people or groups:
Add...
[:} ‘ Remove
_LD is allowed to do the following:
Read any Calendar Entry, To Do or Contact [ Change Access...

9. You can later change the access via the Change Access... button or remove the person
from the access list by clikcing on Remove

Add a shared calendar to your calendar
You add a shared calendar like this:

1. In the left menu of your Notes calendar, you expand Show Calendars and click on
Add a calendar...:

~ Show Calendars

Add a Calendar. .. “

A3 Hanna Ra Dattarcon

2. This window appears:
Add

Add: Notes user's calendar v

Add Notes user's calendar

*User name: (2

[ View this calendar when offline (2

Calendar Entry Formatting
Set display options for the added calendar's entries: (2)

Background: Text: Entry icon:

v | - | coiends: gray

0K Cancel
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3. You can now search for a Notes user and then choose the colors you want this user's
calendar entries to be displayed with. Click OK when finished

4. To toggle on and off this users calendar, you can check and uncheck the calendar from
the list of your calendars:
~ Show Calendars

Add a Calendar...

Color code calendar entries

Just like in Outlook, you can also color code your calendar entries. This means that calendar
entries matching certain criteria that you set will be colorised so that you can differentiate the

various appointments with a quick glance.
You do this by adding a category to a calendar entry:

1. When you create a calendar entry, like a meeting, you can add a category by clicking
here:

When: Starts: [tir 16.03.2021 B [15:00 o [u

Ends: tir. 16.03.2021 (| | 16:00 ®| |u

Where: W[

Categog:‘I/ HCL

Nacr Arintinn I

If the Category option is not there, click on the button Display and choose Category:
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Save and Close | Displayv  Check Calendar...

] Category _
v Additional Mail Options

Calendar Entry

Type: Appointment

’ Subject |etsConnect connects! Confirmation
When: Starts: [tir. 16.03.2021 B [15:00 o L
Ends: tir. 16.03.2021 | | 16:00 o] L

2. After clicking Category, you will get a list of all your categories in popup window:

Categories

a5

vl

HCL

EA

i

[

L]

Holiday

[ Vacation
] Projects

Clients

Travel

Choose one or more categories:

["| Phone Calls

Cancel

N v

Add category:

b\

3. You can add more than one category by checking it. To add a new category, simply
type it in the Add category field

4. Click OK

5. To the right of the Category field you find an option called Assign Colors...:

Where:

Location:

! Category:

[HeL

- AssignCoIorsl

Racerintion |
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6. Click on it and this popup appears:
Preferences E] E’

Mail | i | Access & Delegation |

Display I Scheduling I Alarms l AutoprocessingJ Colors I Rooms & Resources @

’ Calendar - Colors T
z

Calendar Entry Colors I Category Colors I /
Calendar Entry Category Colors »
'You can use Mail - Sender Colors for your Calendar Entries as well. (2)
Note: You can add Categories on the Calendar & To Do - Display - Entries

tab.

Select Categories and the Color to associate them with:
HCL

NCUG, Collabsphere ‘:J I:l
Konsert A

) | ]
Brainworker [

B 2o o
Familie, Venner [:J_E] I:l
o ]

ol
To add categories to this color set, click l\:J E _2]
|Tc add categories to this color set, click ... l\:J ‘:_] _Z]

} Restore Default Colors

=8
Q

|Ta add categories to this ¢

T S

y]

Note: You can add Categories on the Calendar & To Do - Display - Entries tab.

7. Click on one of the buttons looking like the button the arrow in the illustration above
IS pointing at to select the category or categories you want to give a certain color

8. Then you choose the background color and text color for this category

9. Click OK when finished
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10. The calendar will immediately be updated with this color. Here is an example of a
calendar with color coded entries:

Moen Tue Wed Thu Fri Sat Sun
Oct 26 27 28 29 30 3 Nov 1
|Collabsphere | Collabsphere | ~ [Collabsphere ~13:00  Webmete WN
|17:00 Actvities Plus_?_16,00 Notes/Dom| {9'30 Hogne Be B
119:00 Get plugged in(17:00 What's new| [11:26 Vaksinasjol
(20:00 Wine Tastings! 18:00 Domine - 3 (43:00,.. Invitasjon: #
{1a:an Mirreon fe v (1500 Qhant mal ¥
Nov 2 3 4 5 6 7 8
110:00 | banken for oy
Nov 9 10 11 14
(18:00. . PreviewofHCI 1© 00 Styevote| (160000 Keynote:R W W
1900 Rescredul  ikiollons USdSeuShoutins dGASubissvoudei
! 474G Rasdman-! Y 4R:00  Raund ekl ¥
Nov 1 18 19 21 22
19°00 Lutefisk
Nov23 24 5 26 27 28 9
110.00  Webmete WN 800 1.5
Nov 30 Dec1 2 3 4 5 6
|10:00 Sette opp Offid

Change calendar views

In Outlook you choose in the top ribbon menu if you want to see a calendar displayed as a
day, week, work week, month or as a schedule.

Period views

In Notes you switch between a day, two days, a work week, a week or a month and as a
weekly planner under the left side menu item called Views:

Today Mar 5, 2021

4 March 2021 )
M TWTTF S §
1 2 3 4/5/6 7
8 910 11 12 13 14
15 16 17 18 19 20 21
22 23 24 25 26 27 28
293031 1 2 3 4

One Month
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Summary or timeslots

You can switch between viewing the calendar as a summarised calendar or as timeslots by

clicking on the Switch button in the upper right of the calendar:

Show + &) Sametime Contact:

Preview on Bottom
Preview on Side

® Hide Preview

Filter by >

® Summary
Timeslots S

Calendar Footer

ht

ANBTIT

Timeslots will display the calendar like this:

Tuesday, March 2, 2021

Expanded Twistie Icon )

I 09:05 - 10:00

10:35 - 12:.05

€ Wednesday, March 3, 2021

11:00 - 14:00

& Thursday, March 4, 2021

09:20 - 10:20
11:00 - 14:00
16:00 - 17:00

A ss__a_ .. mE___L N AANna

{ March 2021

e Bodo, Norway, March 2021

Bodo, Norway
o SK4519 Molde to OSL

Molde
) SK4106 OSL to BOO

Oslo (OSL)
Digital Week Comes To You EMEA - Day 1

Join the event at hitps:/hclsw.co/ds-dw-emea-attend
hcl_digital_solutions_events

(4] Legetime
Derjeger
Digital Week Comes To You EMEA - Day 2

Join the event at https://hclsw.co/ds-dw-emea-attend
hcl_digital_solutions_events

®© Meet-Up - HCL Connections Guide Program Exchange
https://ht-group.zoom.us/j/95794941629
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Week numbers

Week numbers are displayed in the calendar footer at the bottom of the calendar. You turn it
on like this:

1. Make sure the calendar footer is turned on by clicking on Display and then choose
Calendar footer:
Show ~ &) Sametime Contac

Preview on Bottom
Preview on Side

® Hide Preview
Filter by >

Summary

® Timeslots

—_—

[ Calendar Footer h

2. The calendar footer will now be visible under the calendar view. Click on the little
pulldown arrow to choose Week [Number]:
31 Apr 1 2 3

Day 64 - 301 days left in the year
® Week 9 - 43 weeks left in the year
Month 3 - 9 months left in the year

+ Show Calendar Footer
Week 9 - 43 weeks left in the year J
R - Ssaccctecmspnre |

You can also do this in Day at a Glance in the right sidebar panel.
Find available time
Check one person’s schedule

You can quickly check if a colleague is available by right clicking on an email from this
person and choose the name of the person and then select Find Available Time...:
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- g o
>

Q Search e ;

P QuickFlag — S
nende end P Moveto Folder... . . :
n a0 med Mark as N Add to Contact List... L

- Edit Nickname...
- Add Sender to Contacts... EEAAMOEREIIE L
Chat Histo

ICL _r,d,o,m? d F Reply 5 ry
s U €3 Replyto All > Collaboration History |
3 z €
: 3 Forward Find Available Time... |>
nvoice from Copvinto New 5 Show in Organization View

You will now see a pop up window where you can select a time where both of you are green
and then you can click on Create Meeting.

Check the schedule for meeting participants

If you are creating a meeting you can check when people you have added to the meeting are
free. You do can do this by clicking on the Find Available Times tab, next to Description:

Online Meeting: There is no online meeting

Category: [

Description ] Find Available Times H\Hn]

Select Invitees to find free time for just those individuals.
 Summary ** Details

Refresh Schedule Information

onsdag 10. mars 2021 v

Invitees 07 080910 11 121314 1516 17 181920 21 22 23 00 01 02 03 04 0

/| Allpeople HEEE ] e L
[ Hogne Be Pettersen/ELFWORLD

/| Bl Reguired EEIEEE Flllllllllllllllll
/!
Vil

-

Crhndulad Danme A M A 4m 44 4m A 4 s s Am A Am A R R4 e e AA A AR A A A

If the bar turns green, it means everybody whose schedule you have access to are available. If
it's red, it means one or more of the invitees are busy at the proposed time.

You can move the bar around to change the date and time of the meeting. You can even
increase or decrease the size of the bar to change the length of the meeting.
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View Invitee Status

It is very easy to check who have replied to your meeting invite, and whether they have
accepted or not. Simply open the meeting document and click on the button Invitee Status.



Contacts

Like in Outlook, you have your own personal Contacts app in your Notes client. You can add
contacts and organise them in groups. You can also control the addresses that are displayed
when you type email addresses into the To field in a new email.

Add contact

From Malil

You can add a contact from an email by right clicking on the email and choose Add Sender
to Contacts.... A popup window will appear where the email address and name fields
automatically will be filled out. You can then add more details, if you want. After clicking on
OK, the contact will be added to Contacts.

From Contacts

Open your Contacts application and click on the My Contacts item in the left side menu and
then simply click on the New button above the contacts view. A popup window will appear
where you can add some basic information about the new contact.

If you want to fill in more details about a new contact, click on the pulldown arrow to the
right of the New button and choose Contact. A form will now appear where you can add a lot
of details about the new contact.

Create contact group

You can also organise your contacts into groups.

1. Open your Contacts application and click on the Groups item in the left side menu

2. Give the group a name and a description:

[ Mark private

. Group Name: iNew Notes users

Description:  |A group for previous Outlook users who need user training in Notes

1

Members:

3. Go to the field Members

4. Start typing the name of the contact you want to add. Notes will automatically suggest
names from already existing contacts. Click on the one you want and click the enter
key on your keyboard to start adding a new one. You can also add the email address of
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contacts that aren't in your Contacts register. Just type the email address and hint the
enter key. You can also click on Members. You will then see this popup:

Select Names

Choose the directory, then type all or part of the name.

Directory: ELFWORLD'’s Directory ~ % View by: | List by name
Find names starting with: [l | Names

& Administration Requests A & Names:

& o - 'OR .0 :

2 Domino . Admin 3

& |BM Notes/Domino Fault Reports T &

& |BM Notes/Domino Smart Upgrade Tracking Re &

& LocalDomainAdmins

& LocalDomainServers N

You can now select people from your company directory. If you want to add people
from your personal Contacts, change to your contact application in the Directory pull
down field:

Choose the directory, then type all or part of the name.

Directory: ELFWORLD's Directory
Pettersen’s Contacts
Find names starting with: (EL FWORLD's Directory
Local Address Books
i Administration R Bigfoot

ik domino-42 elfwliensign

You can use the Find names starting with field to type the beginning of a person's
name to find the person you are looking for, if you do not want to scroll through the
list
5. Click OK
6. Click Save and Close
You can now use the group when sending emails or meeting invites.

Recent contacts

When you create a new email and start typing the address or name of a person in the To, Cc or
Bcc field, Notes will suggest names and addresses for you:

To |
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Sometimes Notes will suggest email addresses or contacts that you don't want to see in the
typeahead. You can fix this in Contacts:

1.

2.

3.

4.

Open Contacts
Click on the Recent Contacts item in the left side menu

Find the address or person you don't want to see in the typeahead anymore and click
on him or her

Now click on the button over the view called Hide in Typeahead

It will now no longer show up in in the typeahead. If you want it to show up again, you just
repeat step 1-3 and then click on Show in Typeahead in step 4



Todo

In Outlook you have an application called Tasks. In Notes this is called To do.

Createa To do

As described under Mail, you can turn an email into a To do, just like in Outlook. But you can
also create a To do from scratch:

1. Open the To do application

2. From any folder inside To do, you can click on the New button in the upper left corner
above the folder. This form will appear:

@ To Do Entry
@ roity  Medium v
Subject: |
When: Due by: ™
Start by: ™
Repeat: This entry does not repeat
Who: Assign to: * Me " Others
Cateqgory:
Description
Aftach...

3. You can set a priority, a due date, a start date and whether this is a To do that should
be repeated or not (if you click on Repeat you can choose a whole range of repeating
patterns). You can also assign this To do to another person. In addition you can
categorize it and add further details in the rich text field Description

4. 1f you choose a due date, an option called Notify Me will appear in the upper right
corner of the form:
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If you click on the clock icon you can choose when you should be notified, and how.
5. Click on Save and Close when finished

Mark a To do as completed or incomplete

To mark a To do as completed, simply right click on it and choose Mark Complete. You can
also open it for editing and click on the button Mark Complete.

You mark a completed To do as incomplete in the exact same way. To see your completed To
dos, click on the menu item Complete in the left side menu in the To do app.
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Summary

Hopefully, these tips will ease your users transition from using Outlook to using Notes instead
as their email, calendar, and contacts application.

It will probably also give a lot of good tips to already experienced Notes users.

Anything | forgot? Anything | should leave out? Let me know at hbp@elfworld.org
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